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[bookmark: _Toc254184796]Installing Microsoft Dynamics 5.0 SP1 Update 2
[bookmark: _Toc254184797]Installing the Client
The installation procedure for the Microsoft Dynamics® NAV client varies depending on whether you have Microsoft Dynamics NAV already installed and what version of Microsoft Dynamics NAV you currently have installed:
1. If you do not have Microsoft Dynamics NAV installed, run Setup.exe, located in the CsideClient directory on the installation media. 
1. If you have Microsoft Dynamics NAV 5.0 or Microsoft Dynamics NAV 5.0 SP1 installed, run Setup.exe, located in the CsideClient directory on the installation media and select "Update." After completing Setup, start the client and connect to your database to update it.
1. If you have a pre–Microsoft Dynamics NAV 5.0 version of the client, uninstall it and then install this version.
If you are prompted to convert the demo database when you first start the client, go ahead and do so.
Note for Norwegian version: If you see multiple identical instances of "Norsk (Bokmål)" when the client prompts you to choose an application language, you must choose the first instance in order to see the user interface with the correct language strings.
[bookmark: _Toc254184798]Installing Other Components
Other components that have been updated are Outlook Integration and Employee Portal. For these components, uninstall any previous versions and then run the appropriate Setup program in the appropriate subdirectory. Also see Outlook Integration Installation and Setup Technical White Paper for Microsoft Dynamics NAV 5.0 on PartnerSource.
[bookmark: _Toc254184799]User Access Control (UAC) Installation Issues
If you are installing this update on Windows Vista, Windows Server 2008, or Windows 7, and User Access Control (UAC) is enabled, the following issues exist:
· If you install the demo version on a computer that does not already have Microsoft® SQL Server® installed, Setup installs SQL Server Express automatically. You must then add yourself as an administrator in SQL Server after Setup completes. If you fail to do so, you do not have access to create the $ndo$srvproperty table on the master database. This issue can also occur if you already have the MSSQLSERVER service installed, if you are not already an administrator of the instance.
· If you install the demo version, the xp_ndo.dll stored procedures are not installed correctly. To install these procedures follow the steps described in this blog post: http://blogs.msdn.com/nav/archive/2009/05/25/installing-stored-procedures-for-dynamics-nav-2009-manually.aspx.
· Setup is not able to install the demo database. Follow these steps to install the demo database manually:
1. Copy the database file from the installation DVD (CsideClient\Program Files\Microsoft Dynamics NAV\CSIDE Client\Demo Database NAV (5-0)_Data.mdf) to the Data directory of the local SQL Server installation (typically, C:\Program Files\Microsoft SQL Server\MSSQL.1\MSSQL\Data).
2. Follow the procedure for “Opening Databases” on pages 52-54 of the manual “Installation & System Management: Microsoft Dynamics™ NAV Classic with Microsoft SQL Server™” (w1w1isql.pdf). If you cannot locate your copy of this manual, it is available from the Microsoft Dynamics NAV 5.0 Developer and Installation Guides page in the Microsoft Download Center. It is also possible to attach a database using SQL Server Management Studio. See this blog post for details: http://blogs.msdn.com/nav_developer/archive/2008/11/08/basic-sql-how-to-attach-a-database-to-sql-server.aspx.
[bookmark: _Toc254184800]What’s New in this Update
[bookmark: _Toc254184801][bookmark: _Toc252785080]Support for new Windows operating systems 
Microsoft Dynamics NAV 5.0 SP1 Update 2 is verified to run on Windows 7 and on Windows Server 2008 R2.
[bookmark: _Toc252785081][bookmark: _Toc254184802]New style Sheets for exporting to Microsoft Office
Microsoft Dynamics NAV 5.0 SP1 Update 2 includes two updated style sheets (NavisionFormToWord.xslt and NavisionFormToExcel.xslt). These style sheets were updated to support export of Picture Boxes to Microsoft Office Word and Microsoft Office Excel®.
If you never export forms that contain PictureBoxes, you can choose not to use the updated style sheets.
If you have developed custom style sheets, you can manually merge the changes to your existing style sheet and then import the merged style sheet. Otherwise just import directly. 
To import the style sheet to existing databases (both demo and customer databases), follow these steps:
1. Open the Microsoft Dynamics NAV 50SP1 Update 2 client.
2. On the Tools menu, click Manage Stylesheets to open the Manage Style Sheets form.
3. Choose Style sheets for this form only.
4. Use the Function button to import the updated style sheet. 
[bookmark: _Toc254184803]Known Issues in This Update
[bookmark: _Toc252785083][bookmark: _Toc254184804]Incorrect documentation description for functions TABLENAME and FIELDNAME
The C/AL Programming Guide contains an error regarding the use of FIELDNAME and TABLENAME. On page 27, in the section on User Messages, the text states that "C/AL functions FIELDNAME and TABLENAME should be used in user messages." The text should identify FIELDCAPTION and TABLECAPTION instead of FIELDNAME and TABLENAME.
[bookmark: _Toc252785084][bookmark: _Toc254184805]Database server MMC cannot create snap-in
As a workaround, you can manage the Database Server from the DOS prompt. For information on how to do this, see the manual “Installation & System Management: C/SIDE Database Server for Microsoft Dynamics NAV” (w1w1NACG.pdf), which is available from the Microsoft Dynamics NAV 5.0 Developer and Installation Guides page in the Microsoft Download Center. In the manual, see section 2.3, “C/SIDE Database Server for Microsoft Dynamics NAV Setup Properties.”

[bookmark: _Toc254184806]
Hotfixes Included in This Update
	Link to Knowledge Base Article
	Title of Knowledge Base Article

	975345
	The last Outstream.Writetext statement is not considered by the string.LEN function or the string.TRUNC function in Microsoft Dynamics NAV 4.0

	954722
	Microsoft Dynamics NAV crashes when you try to open some forms

	973043
	The Thai version of Microsoft Dynamics NAV 5.0 with Service Pack 1 client crashes when you click the File menu or the Edit menu in a Terminal Server session

	973954
	The "Sales Budget Overview" form may miss values and column header names when you maximize it in Microsoft Dynamics NAV 5.0

	973133
	Some printers are not displayed in Microsoft Dynamics NAV 5.0

	973626
	The N/ODBC drive returns no data when you run a query that uses some local characters in the WHERE clause in Microsoft Dynamics NAV 5.0 with Service Pack 1

	973584
	The value in a field is changed by a value that you select for a field filter on the field in Microsoft Dynamics NAV 5.0 Service Pack 1

	960661
	The vendor list is not opened when you click the lookup button of the vendor list in a plane report of the table (32) in Microsoft Dynamics NAV 5.0 that has hotfix 957733 applied

	971172
	Slow performance when you apply a filter to a form that is based on a large table in Microsoft Dynamics NAV 4.0 Service Pack 3 and Microsoft Dynamics NAV 5.0 Service Pack 1

	963700
	The Microsoft Dynamics NAV 5.0 Service Pack 1 client crashes when you run C/AL code in which the FieldRef variable is declared as a global variable

	962005
	Spaces after the first white space are truncated when you import data by using an XML port in Microsoft Dynamics NAV 4.0 Service Pack 3 and in Microsoft Dynamics NAV 5.0 Service Pack 1

	967318
	A document is truncated to 44 KBs when you send the document by using the Microsoft dynamics NAV 5.0 communication components

	968196
	Error message when you enable MaintainSQLIndex or MaintainSIFTIndex in Microsoft Dynamics NAV 2009: "Cannot drop the index 'CRONUS International Ltd_$Cust_ Ledger Entry.$6'"

	969452
	The xRec and Rec are the same and the change log does not detect any changes when a record is changed from a sub form in Microsoft Dynamics NAV 5.0

	968465
	The XML port returns an additional error message when you execute an XMLPort import in Microsoft Dynamics NAV 5.0 Service Pack 1: "The XML Parser setup fails"

	969037
	Microsoft Dynamics NAV 5.0 becomes unresponsive when you perform a search process in a list-type form

	969777
	Some temporary files are not deleted as expected when the Microsoft Dynamics NAV 5.0 application service stops

	970545
	Menu items or menu groups that are sent to shortcuts disappear from the original menu in Microsoft Dynamics NAV 2009 or in Microsoft Dynamics NAV 5.0 SP1

	970913
	The card form does not show the detailed information for the record in a list form in Microsoft Dynamics NAV 5.0

	971797
	You receive a permission error when you use LinkedObject tables that have the LinkedInTransaction property set to No in Microsoft Dynamics NAV 5.0

	972793
	The Microsoft Dynamics NAV 5.0 client crashes when you perform a Contact Search process

	974152
	The GETLASTERRORTEXT statement does not work as expected during the XMLport data validation in Microsoft Dynamics NAV 5.0

	975673
	Microsoft Dynamics NAV 5.0 crashes when you open too many dialog boxes

	974890
	Journals in the queues are enabled when you use the Message Queuing Bus adapter to connect to Message Queuing in Microsoft Dynamics NAV 4.0

	974798
	The fast forward-only pointer replaces the dynamic pointer when you run the Microsoft SQL Server Option for Microsoft Dynamics NAV 5.0 SP1

	976327
	The Microsoft Dynamics NAV 4.0 client crashes when you delete a record in a List form by right-clicking Delete

	957275
	Microsoft Dynamics NAV 4.0 crashes when running on a Citrix server if captions contain an ampersand

	976273
	The result set is incorrect when you apply a filter on a form in Microsoft Dynamics NAV 2009

	974802
	Some records in a table are displayed as "#Deleted" when you create the linked table in Microsoft Access by using the Microsoft Dynamics NAV 5.0 N/ODBC-connection data source

	975913
	Error message when you select an Automation object in Microsoft Dynamics NAV 5.0: "The length of the text string exceeds the size of the string buffer"

	976254
	The records in a table are displayed as "#Name?" when you create a linked table in Microsoft Access by using the Microsoft Dynamics NAV N/ODBC-connection data source

	976911
	Error message when you try to change a table that has a primary key field defined by using Variant as the SQL data type in Microsoft Dynamics NAV 4.0: "Invalid cursor state"

	954672
	You may experience slow performance when you run some jobs and some queries in Microsoft Dynamics NAV 4.0 that has hotfix 950920 installed or in Microsoft Dynamics NAV 5.0 with Service Pack 1

	957471
	Error message when you try to restore a backup in Microsoft Dynamics NAV 5.0 with Service Pack 1 installed: "Company Name '[Company_Name]' does not exist"

	959158
	Error message when you perform the Copylinks function by using a recordref-type variable in Microsoft Dynamics NAV 5.0: "Type conversion is not possible because one of the operators contains an invalid type. Record := Recordref"

	967158
	Error message when you restore a customer database on Microsoft Dynamics NAV 4.0 Service Pack 3 (SP3) Native backup to the Native option for Microsoft Dynamics NAV 5.0 SP1 Client: "Internal Error 1355 in Module 19"

	957824
	Changes in the "Production Schedule" dialog box are not saved in Microsoft Dynamics NAV 5.0 Service Pack 1

	957267
	Microsoft Dynamics NAV 5.0 may display an incorrect character when you type a DBCS character in a field

	960607
	The characters that indicate an empty HTML cells are incorrect displayed as "&nbsp" in Microsoft Dynamics NAV 5.0

	959656
	Error message when a lock time-out occurs in the Microsoft Dynamics NAV 4.0 client: "Error: [Microsoft][ODBC Driver Manager] Function sequence error"

	977122
	The Microsoft Query executable file crashes when you use the NODBC data source to access a Microsoft Dynamics NAV 5.0 database from Microsoft Excel

	957276
	You obtain different results when you run the same code by using the Fin.exe file and the Finsql.exe file in Microsoft Dynamics NAV 5.0

	954342
	You may experience several issues when you set a filter in a list form in Microsoft Dynamics NAV

	965224
	Memory is not released when you open a new company in Microsoft Dynamics NAV 4.0

	973045
	The Microsoft Dynamics NAV 5.0 client crashes when you use the Error function in the OnCloseForm trigger

	970502
	Error message when you install the Microsoft Dynamics NAV Employee Portal components on a computer that is running a 64-bit operating system: "Sharepoint Services are not installed on the system"

	973045
	The Microsoft Dynamics NAV 5.0 client crashes when you use the Error function in the OnCloseForm trigger
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Issues Resolved in This Update
· Multiple issues detected by Windows Error Reporting, which could cause Microsoft Dynamics NAV 5.0 SP1 components to stop responding, were resolved.
· Multiple issues that were determined to be decreasing the amount of memory available to the computer running Microsoft Dynamics NAV 5.0 SP1 over time were resolved.
· Issue: TRANSFERFIELDS function would transfer too many characters. Resolution: For file copying, the actual field's size is now used, and not the aligned size.
· Issue: Comcom implementation was not working correctly. Resolution: Fixed.
· Issue: SKIP function was not working when importing through an XMLport. Resolution: Fixed.
· Issue: Restoring a Microsoft Dynamics NAV database containing several companies on SQL Server 2005 would return a system memory error. Resolution: The loop for creating table data entries for each company will now look at a snapshot that is taken at the beginning of the restore, which contains all existing companies. Because companies from the restore are inserted directly into the company table, there must be a separate company list to represent the original companies. Based on this snapshot, no tables will be created for existing companies in the backup section.
· Issue: Filter function created in earlier version of Microsoft Dynamics NAV would not work in version 5.0. Resolution: Fixed.
· Issue: Problems with DBCS characters, especially in double-byte languages. Resolution: Fixed.
· Issue: Maximum number of allowed client users could be exceeded on client. Resolution: Fixed.
· Issue: Potential instability when designing Automation with events. Resolution: Fixed.
· Issue: It was impossible to create more than one clustered index on table. Resolution: Fixed.
· Issue: Error 2 in module 5. Resolution: Fixed.
· Issue: Problem with using the Printer Selection feature in Microsoft Dynamics NAV when running with Terminal Services on Windows Server 2008 or Windows Server 2003. With more than one client user, Microsoft Dynamics NAV was unable to identify which printer belonged to which user. Resolution: Fixed.
· Issue: Export of images to Base64 for export to Microsoft Office was not working. Resolution: The export of images is now supported using Base64.
· Issue: Restoring a backup did not restore Windows logins. Resolution: Windows logins are now restored from a backup.
· Issue: Saving a report as HTML would lead to a corrupt .zup file. Problem would occur if user attempted to resave a report while the original version was still in use. Resolution: Fixed.
· Issue: ASSERT messages were being inappropriately displayed. These messages were a testing artifact that should have been removed. Resolution: Fixed.
· Issue: Incorrect calculation of UTC would lead to incorrect start date/time in routing lines. Resolution: Fixed.
· Issue: C/AL code behaved differently depending on whether it was executed by fin.exe or finsql.exe. Resolution: Fixed.
· Issue: Planning Worksheet could not be exported to Excel. Resolution: Fixed.
· Issue: Database upgrade would incorrectly complete even when errors occurred. More specifically, security synchronization would not be completed, but the database would still be upgraded, though it would not be 100% functional until the security failure had been corrected and a security synchronization was performed. Resolution: The transaction was changed so that the update is not submitted until the security synch is completed.
· Issue: Use of pipe OR operator in security filters displayed strange behavior when browsing through a list form. Resolution: Fixed.
· Issue: Errors in the Outlook Integration installers. Resolution: Fixed.
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